BillQuick

Time Billing and Business Management Software

Built With Your Industry Knowledge

BillQuick<->QuickBooks Integration

Integration Guide

BQE Software, Inc.
2601 Airport Drive
Suite 380
Torrance CA 90505
Support: (310) 602-4030
Sales: (888) 245-5669
Fax: (310) 784-8482

©2005-2011 BQE Software, Inc. All rights reserved. No part of this publication may be reproduced, transmitted, stored in a retrieval system, or translated into any language in any form by any means without written permission of BQE Software, Inc.
Table of Contents

INTRODUCTION .................................................................................................................. 1

How to Use This Guide ........................................................................................................ 1
Software Editions Supported ................................................................................................ 2

HOW INTEGRATION WORKS .......................................................................................... 3

MODES OF SYNCHRONIZATION ......................................................................................... 4
INTEGRATION RULES ........................................................................................................... 5
INTEGRATION SETTINGS ..................................................................................................... 8
Send Settings ........................................................................................................................ 8
Get Settings ........................................................................................................................ 10
QuickBooks Accounts ......................................................................................................... 12
Payroll Settings ................................................................................................................. 19
QuickBooks Class .............................................................................................................. 21

INTEGRATION WIZARD .................................................................................................... 23

QuickBooks Integration Wizard .......................................................................................... 23

INITIAL INTEGRATION ....................................................................................................... 28

SECURITY PERMISSIONS ................................................................................................... 28
SCENARIO 1: EXISTING BILLQuick-NEW QuickBooks USER ........................................... 31
SCENARIO 2: NEW BILLQuick-EXISTING QuickBooks USER ............................................ 36
SCENARIO 3: NEW BILLQuick-NEW QuickBooks USER ..................................................... 42
SCENARIO 4: EXISTING BILLQuick-EXISTING QuickBooks USER .................................... 54

QUICK-CHECK .................................................................................................................. 61

DAY-TO-DAY INTEGRATION SETTINGS .......................................................................... 66

Master Information ............................................................................................................. 66
Time Records ...................................................................................................................... 67
Expenses ............................................................................................................................ 68
Invoices ............................................................................................................................... 69
Late Fee Invoices ............................................................................................................... 70
Payments ............................................................................................................................. 70
Real-Time Sync .................................................................................................................. 71
Best Practices .................................................................................................................... 73
You will gain the most from this guide by first reviewing it. Also, be sure to back up your data.

Data integration between BillQuick® (by BQE Software, Inc.) and QuickBooks® (by Intuit) can make your time billing, accounting and financial management tasks easier. Full-featured, BillQuick Time and Billing helps you manage your company, whether your time, expense, billing and reporting needs are simple or you require complex billing, reporting and management capabilities. QuickBooks is a business accounting software that provides solutions such as general accounting, accounts receivable, accounts payable, online banking, reporting, payroll, and other functions. Integrated, BillQuick and QuickBooks deliver a virtual application that ensures data accuracy, eliminates time-consuming duplicate manual entry, enhances flexibility, and increases control over your bottom line.

The goal of the BillQuick↔ QuickBooks Integration Guide is to help you effectively integrate data between BillQuick and QuickBooks. BillQuick controls integration, enabling you to choose accounts, what data flows between the applications, and much more.

Check out BillQuick Training at www.BillQuick.com/Services.asp for a standard or custom training course on data integration with QuickBooks. BQE Software also offers Consulting services in these areas.

How to Use This Guide

Integration means data from one application transfers to another. This sharing offers many benefits. You control what data transfers to and from BillQuick using synchronization settings. Your preferences tell BillQuick exactly how you want it to interact with QuickBooks. BillQuick automatically creates smart connections using your settings and its built-in intelligence.

The How Integration Works section is written for users with a non-technical background, explaining the integration rules and setting built into BillQuick. Understanding what type of data may be shared and which rules apply during synchronization, will help you visualize what is happening behind the scenes.

In Initial Integration, you can choose the scenario that best fits your company. Instructions guide you through initial integration, whether you are a new or existing BillQuick or QuickBooks user.

When you reach the point where data is to be checked to make sure it was synchronized accurately, Quick Check section provides specific guidance. Day-to-Day Integration Settings provides suggestions for fine-tuning your synchronization settings for normal, day-to-day sync and also points out the industry’s best practices. It explains the real-time sync option for your daily integration needs.
Software Editions Supported

All BillQuick editions – Basic (Microsoft Access database), Pro (Microsoft Access and SQL Express database) and BillQuick Enterprise (Microsoft Access, SQL Express and Microsoft SQL Server database) – integrate with the following QuickBooks editions:

- QuickBooks Pro/Premier editions all flavors, including the Accountant’s Edition (2002 and later)
- QuickBooks Enterprise Solutions all flavors, including the Accountant’s Edition (3.0 and later)
- QuickBooks Canadian Edition (2004 and later)
- QuickBooks UK (2003 and later)
- QuickBooks Australia (2008 and later)
How Integration Works

Whether you have a technical background or not it is helpful to understand the basics of BillQuick↔QuickBooks integration. This can help you visualize what is happening behind the scenes as BillQuick manages the transfer of data to and from QuickBooks.

There are some differences between QuickBooks and BillQuick that need to be understood in order to ensure smooth and accurate data integration. BillQuick is project-centered and supports a hierarchical structure while as QuickBooks is client-centered and utilizes a flat project structure. Each record common to BillQuick and QuickBooks share a unique Link ID that identifies them as related. This does not mean data in both databases is exactly the same; only that they share common data. BillQuick Project records contain data and options that QuickBooks Job records do not and vice versa. What is important for integration are that the two applications share key data.

⚠️ Back up your data in QuickBooks and BillQuick prior to data sync.

The table below shows the direction data can potentially flow between BillQuick and QuickBooks. Whether it flows in one direction or the other (or both directions) depends on choices made on the Integration Settings screen. You can be very specific in determining how data flows to and from BillQuick, and also which General Ledger accounts in QuickBooks are posted.

<table>
<thead>
<tr>
<th>BillQuick Table Name</th>
<th>Dataflow</th>
<th>QuickBooks Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Codes</td>
<td>↔</td>
<td>Service Item</td>
</tr>
<tr>
<td>Expense Codes</td>
<td>↔</td>
<td>Other Charge Item</td>
</tr>
<tr>
<td>Employee</td>
<td>↔</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendor</td>
<td>↔</td>
<td>Vendor</td>
</tr>
<tr>
<td>Client</td>
<td>↔</td>
<td>Customer</td>
</tr>
<tr>
<td>Project</td>
<td>↔</td>
<td>Job</td>
</tr>
<tr>
<td>Time Entry</td>
<td>↔</td>
<td>Time Tracking</td>
</tr>
<tr>
<td>Expense Log</td>
<td>↔</td>
<td>Bills/Checks</td>
</tr>
<tr>
<td>Invoice</td>
<td>↔</td>
<td>Invoice</td>
</tr>
<tr>
<td>Payment</td>
<td>↔</td>
<td>Payment</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>↔</td>
<td>Bills</td>
</tr>
<tr>
<td>Chart of Accounts</td>
<td>↔</td>
<td>Chart of Accounts</td>
</tr>
<tr>
<td>Estimate</td>
<td>←</td>
<td>Estimate</td>
</tr>
</tbody>
</table>

⚠️ To review detailed, field-by-field mapping of records between QuickBooks and BillQuick, see BillQuick Help, BillQuick↔QuickBooks Integration, Table & Field Mapping.
As you can see above, BillQuick’s integration with QuickBooks is very comprehensive. Not only are invoices sent to QuickBooks to post revenue and receivables, the virtual database for the two applications includes clients, projects/jobs, employees, vendors, activity codes, etc. BillQuick creates a log that records the events and exceptions involved in data sync with QuickBooks. It flags this log file with a date stamp.

After initial integration, you may set integration rules so that master information transfers only from BillQuick to your accounting package. You would choose ‘Do Not Get Data’ (i.e. turn off the flow of data) in the Get Settings. In other words, you decide to maintain master data in BillQuick only. It flows to your accounting package, updating its database and keeping information synchronized. You can be just as specific when assigning General Ledger accounts to activity codes, expense codes and invoice items.

Bottom Line: The major benefit is that you do not have to re-enter BillQuick data into QuickBooks. BillQuick manages the process, using your synchronization settings.

Modes of Synchronization

BillQuick offers three modes of synchronization with QuickBooks.

<table>
<thead>
<tr>
<th>Synchronization</th>
<th>QuickBooks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-Time</td>
<td>✔</td>
</tr>
<tr>
<td>On-Schedule</td>
<td>✔</td>
</tr>
<tr>
<td>On-Demand</td>
<td>✔</td>
</tr>
</tbody>
</table>

1 Requires QuickBooks 2004 or later

Real-Time Synchronization means that data integrates between BillQuick and QuickBooks when you update a record in either application. Real-Time Synchronization is completely automatic and requires no action on your part. However, you will need to specify this option in the QuickBooks Integration Wizard or QuickBooks menu only once and then from that point onwards, data is synchronized automatically. See Real-Time Sync for more information.

In contrast, On-Schedule Synchronization means that BillQuick reminds you to synchronize on the schedule you choose. The schedule may be daily, weekly or when you start up or exit BillQuick (set in Global Settings-Reminders screen).

On-Demand Synchronization allows you to transfer all updated data or just one record at a time, whenever you want. BillQuick includes an on-demand sync option for QuickBooks on many screens in the form of a Send To button or right-click option. You can send a new or changed record from BillQuick to QuickBooks instantly and directly from the screen you were working on. This saves time when you make only a few quick additions or changes and want to instantly update the database.

Generally, for mass or group data sync, you would use the Integration menu, QuickBooks, Get/Send sub-menu. The menu provides various sync
options enabling you to control sending and getting data. Hence this option is recommended unless you need to send an invoice or other record right away to QuickBooks.

Integration Rules

BillQuick handles most of the time and billing data differently from QuickBooks. To ensure accuracy and completeness of data transfer, BillQuick→QuickBooks integration follows a set of rules. These are:

1. **Company:** Accounting systems accept the transfer of time, expense, invoice, and payment records only if the record dates are after the start date for the Company.
2. **Date:** When data is transferred from QuickBooks to BillQuick, the system date is converted to Greenwich Mean Time (GMT) and is recorded in the Last Updated field for each record.
3. **Placeholder Data:** Because QuickBooks does not require the same fields of data as BillQuick, and because it may not track the same data as BillQuick (does not have the same fields), BillQuick inserts placeholder data in the required fields—FromQuickBooks.
4. **Synchronization Order:** When you send or get data on-demand (via Send, Get or Sync menu); follow the order of the sub-menu. For example, synchronize Clients before Projects and Invoices before Payments.
5. **Link ID:** BillQuick automatically creates an internal unique identifier called ‘QBLinkID’. It is saved in the database for the records that have been transferred between the two applications and are linked. You can un-link or reset this Link ID for records that have synchronized previously with QuickBooks.

BillQuick identifies the records that have a corresponding record in QuickBooks by displaying 🔄 in the grids.

6. **Backup Copy:** When you restore a backup copy of the QuickBooks (or BillQuick) database, the links between BillQuick and QuickBooks may not be complete or accurate. QuickBooks re-indexes the records, thus breaking all the links with BillQuick. You need to run Smart Match to match up existing records and then sync the remaining records.

If you send a copy of QuickBooks database to your accountant for checking and adjustments, use the accountant’s copy and import those changes when returned.

7. **Rates:** QuickBooks does not require default Bill Rate and Cost Rate values for employees, while BillQuick does. When employee data is transferred from QuickBooks to BillQuick, you will be prompted to update the Bill Rate and Cost Rate in BillQuick. By default, the value is set as $1 for both. For proper job costing and billing, these rates should be updated before using BillQuick for time tracking.
8. **Address**: In QuickBooks, addresses are entered in four one-line fields, while in BillQuick fields are assigned for each component of the address. To ensure accuracy and consistency during data transfer, make sure your address in QuickBooks is entered according to the U.S. Postal Service Standard:
   - Address Line 1
   - Address Line 2 (optional)
   - City, State (2 or 3 character abbreviation), Zip Code (comma separation is optional)

9. **Projects**: When sub-jobs or project phases are transferred from QuickBooks to BillQuick, they are saved as Project Phases in BillQuick.

10. **Clients**: Client contacts from BillQuick automatically transfer to QuickBooks when you synchronize client records.

11. **Time Entry**:
    - You cannot transfer a time-entry older than 01/01/1901 to BillQuick. If a time entry older than this is sent to BillQuick it will be saved with the date 01/01/1901.
    - QuickBooks does not support negative time entries, and hence these entries do not transfer during synchronization.
    - When a time entry or an invoice is transferred from BillQuick to QuickBooks, it cannot be transferred again. In other words changes made to transferred invoices and time entries will not be transferred to QuickBooks.
    - You cannot send unapproved time entries to QuickBooks.

12. **Expenses**:
    - Bills and Checks can be marked as Billable or Non-Billable and transferred with their status from QuickBooks to BillQuick.
    - Checks, Bills and Credit Card Charges can be sent from QuickBooks to BillQuick only if they are associated with a job.
    - Expense Log entries and vendor bills can be sent from BillQuick to QuickBooks, but QuickBooks can accept them only as vendor bills. When employee expenses (reimbursable) are sent to QuickBooks as bills, BillQuick prompts you to pre-define an Employee ID to Vendor ID switch.
    - QuickBooks does not accept negative expenses. If you send invoices with negative line items from BillQuick, the total of all line items has to be positive for data transfer to QuickBooks.

13. **Vendor Bills**:
    - If you want to maintain all project rules and settings related to time and expenses, create your entries in the time and expense entry screens and not in the Vendor Bills screen. This is because Vendor Bills screen does not support rules.
    - Real-Time sync transfers new vendor bills. However, BillQuick does not support updating existing vendor bills.

14. **Invoice**: BillQuick allows you to transfer multiple invoices as well as joint invoices to QuickBooks.
    - When invoices are transferred from BillQuick to QuickBooks, they are transferred with their appropriate time and expense details. Where time has been written up/down, the hours are adjusted using the Write-Up/Down multiplier, \((B \cdot \text{Hours} \times \text{BR} \times \text{WUD})\).
How Integration Works

- Pending invoices in QuickBooks cannot be transferred to BillQuick. Draft invoices in BillQuick do not transfer to QuickBooks.
- If a discount is applied to an invoice using the ‘Discount and Credits’ option on the Payment screen in QuickBooks, BillQuick will NOT transfer this payment. We recommend that you use the Credit Memo option in QuickBooks to properly discount an existing invoice.
- You can send a manual invoice to QuickBooks whether it has an activity or expense item associated with it. Item details can be sent or skipped, depending upon the option chosen in Integration Settings screen.
- While transferring invoices, associated items, units and rates can also be transferred from QuickBooks.
- It is not necessary to transfer time and expense details to QuickBooks in order to send detailed invoices.
- Invoices and Payments in QuickBooks should be linked to Jobs, not Customers. This is because BillQuick is job or project-centric, and invoices and payments are associated with the jobs and not directly to the client. In QuickBooks you can associate invoices and payments directly with the client. In order to get these invoices and payments, BillQuick will create a project on-the-fly based on the client and associate all these transactions to this project.
- When sending invoices to QuickBooks, BillQuick sets the due date based on the Payment Terms specified for the project.
- BillQuick allows you to transfer late fee charges as well as payments to QuickBooks. While transferring late fee invoices and payments, BillQuick will post them to the appropriate QuickBooks accounts.

15. Retainer:
- When transferring client and project retainers to QuickBooks, it saves them as Client Credits in a liability account. These liability accounts are created on-the-fly during the integration process or you can assign the desired liability accounts to the project retainers in the BillQuick-QuickBooks Integration Settings screen (Project Accounts section).
- A negative payment does not transfer over to QuickBooks (retainer refund). You must reduce the ‘BQUnearedRetainer’ amount in BillQuick using a credit memo or directly from the QuickBooks Retainer account. You can issue a refund check from QuickBooks to the client.

16. Payment:
- If a Payment was applied to a Client in QuickBooks and then invoices related to Jobs were paid, it gets transferred as Client Payment and is associated to the correct job.
- Payments from QuickBooks do not transfer to BillQuick if there is no invoice in BillQuick to which the payment amount was applied (the invoice does not exist in BillQuick). Similarly, payments from BillQuick do not transfer to QuickBooks if the invoice does not exist there.
- Debit as well as credit type payments are transferred between BillQuick and QuickBooks. Retainer payments are sent as ‘check’ type by default.
- When paying an invoice in BillQuick using ‘Use Retainer’ option, BillQuick debits the liability account in QuickBooks.
- When we send one payment that pays two or more invoices to QuickBooks, it is not sent as separate payments but rather a single payment.
17. **Credit Memo**: Credit Memos get transferred from QuickBooks to BillQuick as negative invoices (Credit Memo).

   If you transfer credit memos from QuickBooks to BillQuick, the Aging report in BillQuick displays information without considering the credit memo data. To view aging report with this data, use the Aging with Overpayments report.

### Integration Settings

In BillQuick, you can specify data transfer rules and settings in the BillQuick-QuickBooks Integration Settings screen. These settings apply company-wide and are used as defaults when you choose to synchronize data between BillQuick and QuickBooks.

Using the BillQuick-QuickBooks Integration Settings screen, you can specify the following:

- **Send Settings**
- **Get Settings**
- **Account Assignment**
- **Payroll Settings**
- **Class**

### Send Settings

Send settings allow you to set rules for data transfer from BillQuick to QuickBooks database. You can also restrict the data sent from BillQuick to QuickBooks and specify filters.

   The send options change depending upon the module selected from the list on the left of the screen.

You can specify the following settings *per module* for sending data to QuickBooks:

**QuickBooks File**: Your QuickBooks database is displayed here. By default, BillQuick will always connect to the currently open QuickBooks company file. However, if QuickBooks is not running, then BillQuick opens the file specified here.
Options: BillQuick provides some options for sending BillQuick data to QuickBooks:

- **Do Not Send**: Check this option if you don’t want BillQuick to send data for the selected module. E.g. if you do not wish to send time data to QuickBooks, check ‘Do not Send Time Data’ option.
- **Ignore Last Sync Date**: Checked, BillQuick ignores the date when it had last integrated with QuickBooks for the selected module. The Last Sync On date, displayed at the bottom of the screen, is used for reference when we want BillQuick to sync data since this date.
- **Active Only**: Checked, only active BillQuick data is considered for transfer, e.g. active employees, clients, vendors, and so on.
- **Skip during Real-Time Sync**: Checked, the data from the selected module is not transferred to QuickBooks during real-time sync.

For Time Records, you can specify additional options:

- **Map TE Memo to QB Notes**: Check this option to map BillQuick time entry memos to QuickBooks time entry notes.
How Integration Works

- **Transfer A-Hours**: Check this option to transfer actual hours to QuickBooks instead of billable hours (B-Hours).
- **Skip Comp Time**: Check this option if you don’t want to transfer compensation time to QuickBooks.
- **Skip Sending Employee/Vendor Time**: Check any of these options to skip sending employee or vendor time entries to QuickBooks.

**Overwrite Rules for Duplicate Records**: In this section, you can specify the overwrite rules for selected module. For instance, if both BillQuick and QuickBooks have record for employee John Doe:

- **Never**: Neither BillQuick’s nor QuickBooks’ version of field data will be updated. Thus, you will have two versions of that record. E.g., if the employee record has different address in each database, those fields will not be updated upon sync.
- **Always**: BillQuick data will always overwrite the QuickBooks data in the Send mode. Again, if two different addresses exist, the employee address in BillQuick will replace that of QuickBooks.
- **Most Recent**: BillQuick compares the Last Modified On date-time stamps for QuickBooks and BillQuick fields. The more recent one replaces the older data in the other database.

**Filters**: allow you to restrict the data transferred between BillQuick and QuickBooks. For example, you may like to transfer only one group of clients from BillQuick to QuickBooks. The filter fields keep on changing depending upon the module selected. The intersection of data produced by applying all filters is what will be transferred.

- **Date Filters**: Each linked record saves a ‘Last Modified On’ date that is used to determine which record is most recent. The date filters are useful and save time when you want to sync data for a specific period.
- **Other Filters**: Depending upon the module selected, you can also apply other filters to restrict data sent from BillQuick to QuickBooks. E.g., you can filter data by IDs or groups for employees, activities, projects and so on.

**Get Settings**

Get settings allow you to set rules for data transfer from QuickBooks to BillQuick database. You can also restrict the data received from QuickBooks into BillQuick and specify filters.

![Speech bubble] The get options change depending upon the module selected on the left of the screen.

You can specify the following settings *per module* for getting data from QuickBooks:

**QuickBooks File**: Your QuickBooks database is displayed here. By default, BillQuick will always connect to the currently open QuickBooks company file. However, if QuickBooks is not running, then BillQuick opens the file specified here.
Options: BillQuick provides some options for getting QuickBooks data into BillQuick:

- **Do Not Get**: Check this option if you don’t want BillQuick to get data for the selected module. E.g. if you do not wish to get employee data from QuickBooks, check ‘Do not Get Employee Data’ option.
- **Active Only**: Checked, only active QuickBooks data is considered for transfer, e.g. active employees, clients, vendors, and so on.
- **Skip during Real-Time Sync**: Checked, the data from the selected module is not transferred to BillQuick during real-time sync.

For Expenses, you can specify additional options:

- **Skip Non-Billable/Billable Expenses**: Check any of these options if you want to skip getting non-billable or billable expenses from QuickBooks into BillQuick.
- **Skip Getting Credit Cards/Bills/Checks**: Check any of these options if you want to skip getting expenses such as credit card charges, vendor bills and checks from QuickBooks.
How Integration Works

**Overwrite Rules for Duplicate Records:** In this section, you can specify the overwrite rules for selected module. For instance, if both BillQuick and QuickBooks have record for employee John Doe:

- **Never:** Neither BillQuick’s nor QuickBooks’ version of field data will be updated. Thus, you will have two versions of that record. E.g., if the employee record has different address in each database, those fields will not be updated upon sync.
- **Always:** QuickBooks data will always overwrite the BillQuick data in the Get mode. Again, if two different addresses exist, the employee address in QuickBooks will replace that of BillQuick.
- **Most Recent:** BillQuick compares the Last Modified On date-time stamps for QuickBooks and BillQuick fields. The more recent one replaces the older data in the other database.

**Filters:** allow you to restrict the data transferred between BillQuick and QuickBooks. For example, you may like to transfer only one group of clients from QuickBooks into BillQuick. The filter fields keep on changing depending upon the module selected. The intersection of data produced by applying all filters is what will be transferred.

- **Date Filters:** Each linked record saves a ‘Last Modified On’ date that is used to determine which record is most recent. The date filters are useful and save time when you want to sync data for a specific period.
- **Other Filters:** Depending upon the module selected, you can also apply other filters to restrict data received from QuickBooks. E.g., you can filter data by IDs for employees, activities, projects and so on.

**Other Settings:** There are some additional options available for the Employee module. When employee data is transferred from QuickBooks to BillQuick, you have to specify default information that is not available in QuickBooks.

- **Default Bill Rate:** You need to set a default bill rate for employees transferred from QuickBooks. By default, the value is taken as 1. You can also change these values later in BillQuick’s Employee screen.
- **Default Cost Rate:** You need to set a default cost rate for employees transferred from QuickBooks. By default, the value is taken as 1. You can also change these values later in the Employee screen.
- **Set Bill Rate as Pay Rate Multiplier of:** BillQuick allows you to set the Bill Rate from a standard multiplier, based on the pay rate in QuickBooks. Thus, if pay rate changes in QuickBooks, Bill Rate can be easily updated in BillQuick.

**QuickBooks Accounts**

Activity Codes in BillQuick are linked to Service Items in QuickBooks. Similarly, Expense Codes in BillQuick are linked to Other Charge Items in QuickBooks. A key step in the integration process is to assign general ledger (G/L) accounts to BillQuick activity codes, expense codes and other invoice items. In BillQuick, activity and expense accounts are not required, except for the purpose of data integration or accounts payable but QuickBooks requires G/L accounts for all items and transaction.
How Integration Works

For companies that integrate BillQuick with QuickBooks, they need to specify default General Ledger accounts for the service, expense and invoice items in BillQuick (prior to the sync). When BillQuick invoices are transferred to QuickBooks, by default it transfers the actual time and expense line items and posts them to their respective accounts. However, when invoice details are not transferred, BillQuick sends service and expense items as single line items. Normally, the transactions debit or credit these accounts. You can assign G/L accounts to individual activity codes, expense codes and invoice items, or make these assignments at the project/project group level.

QuickBooks accounts are available for assignment in BillQuick only after a connection has been established between the two applications.

If you integrate with QuickBooks and GET service and expense items, the associated G/L accounts also carry to BillQuick. The G/L accounts do not display in the Activity Codes or Expense Codes screens in BillQuick unless they are available in the Chart of Accounts. You can manually set up the Chart of Accounts in BillQuick or transfer it from QuickBooks through data sync. When an activity or expense is part of an invoice (associated time and expense entries are relieved with the invoice), and you synchronize that invoice with QuickBooks, the correct G/L account will be updated there. This tracks your company’s income and expenses in the accounting system.

It is preferable to create activity and expense (other charge) items in QuickBooks and have them transferred into BillQuick. This reduces the step of creating or assigning G/L accounts for them in BillQuick.

Activity and expense accounts can be set up in three ways:

- **Activity Codes and Expense Codes screen:** You can select a QuickBooks Income Account and Expense Account for each activity or expense item, in the respective screens. However, BillQuick retrieves these accounts from the Chart of Accounts and they appear in the drop-down lists only if they are available there. You can manually set up the Chart of Accounts in BillQuick or transfer it from QuickBooks through data integration.
  
  You can click Tools, Assign QuickBooks Account and specify accounts for selected activity or expense item.

- **Integration menu:** Besides the above options, you can assign accounts to BillQuick activities and expense items via the QuickBooks Integration Wizard or BillQuick-QuickBooks Integration Settings-Account Assignment screen. QuickBooks income and expense accounts are available for assignment after a connection between BillQuick and QuickBooks is established.
QuickBooks: If you integrate with QuickBooks and GET Service and Other Charge Items, the associated G/L accounts also transfer to BillQuick.

The BillQuick-QuickBooks Integration Settings screen allows you to specify the desired QuickBooks account to BillQuick items. You can make the following account assignments:

- Default Accounts
- Activity Accounts
- Expense Item Accounts
- Project Accounts
- Invoice Accounts

See the Initial Integration section for step-by-step instructions.

Default Accounts: You can specify default accounts for BillQuick’s activities (service items) and expenses (charge items). Besides these, you can also specify default accounts for summarized activity (service amount charges) and expense (expense amount charges) line items that are invoiced.
How Integration Works

- **Default Account for Service Items**: Every service item in QuickBooks must be assigned to an income account. The QuickBooks income account selected here is assigned to all activity/service items of BillQuick. By default, Other Income account is selected but you can choose any other Account Name from the drop-down list.

- **Default Account for Expense Items**: Every expense item in QuickBooks must be assigned to an income account. The QuickBooks income account selected here is assigned to all expense items of BillQuick. By default, Other Income account is selected but you can choose any other Account Name from the drop-down list.

- **Income Accounts for Services Invoiced**: The QuickBooks income account selected here is where the service total of your BillQuick invoices will transfer upon sync. By default, Other Income account is selected but you can select any other Account Name from the drop-down list.

- **Income Accounts for Expenses Invoiced**: The QuickBooks income account selected here is where the expense total of your BillQuick invoices will transfer upon sync. By default, Other Income account is selected but you can select any other Account Name from the drop-down list.

**Activity Accounts**: Besides the default account, you can specify income and expense account for each BillQuick activity code (service item). You can select an activity (or multiple activities) from the grid and assign the desired account to it. If you leave it blank, BillQuick uses the default account previously specified.
How Integration Works

- **Income Account for Services Invoiced**: The QuickBooks income account chosen here is assigned to the selected activity (or activities). By default, Other Income account is selected but you can select any other Account Name from the drop-down list.
- **Expense Account for Services Invoiced**: The QuickBooks expense account chosen here is assigned to the selected activity (or activities). By default, Other Income account is selected but you can select any other Account Name from the drop-down list.

**Expense Accounts**: As in case of activity codes, you can specify income and expense account for each BillQuick expense code (other charge item). You can select an expense (or multiple expenses) from the grid and assign the desired account to it. If you leave it blank, BillQuick uses the default account previously specified.

- **Income Account for Expenses Invoiced**: The QuickBooks income account chosen here is assigned to the selected expense (or expenses). By default, Other Income account is selected but you can select any other Account Name from the drop-down list.
- **Expense Account for Expenses Invoiced**: The QuickBooks expense account selected here is assigned to the selected expense (or expenses). By default, Other Income account is selected but you can select any other Account Name from the drop-down list.

💡 You can also assign QuickBooks Income Account and Expense Account to individual or groups of activity and expense codes on the Activity Codes and Expense Codes screens in BillQuick.

**Invoice Accounts**: Besides specifying accounts for activity and expense items, you need to specify default income and expense accounts for invoice items. These are the accounts into which the service, expense, tax, retainer, late fee and other amounts on BillQuick invoices transfer upon sync.

With each invoice, BillQuick sends up to four separate tax amounts to QuickBooks as line items. The four items are:
Service Tax Amount – sum of Tax 1, Tax 2 and Tax 3 for time entries
Expense Tax Amount – sum of Tax 1, Tax 2 and Tax 3 for expense entries
Main Service Tax Amount – amount calculated on the total value of services using the MST rate
Main Expense Tax Amount – amount calculated on the total value of expenses using the MET rate

Tax line items transfer whether you choose to send a detailed invoice or a summary invoice. Associating taxes to service items in QuickBooks has two flaws: (1) it treats the tax amount as income, which is incorrect and (2) what you owe a tax agency will not show up in the Sales Tax Liability report in QuickBooks.

To avoid these potential problems, it is highly recommended to assign liability accounts to tax items before sending them to QuickBooks. E.g., Service Tax Amount can be assigned to Sales Tax Payable account and so on. When you do that, the ‘Expense Account’ field changes to ‘Vendor’. It is important to select an appropriate vendor for each liability account.

On the Invoices panel, you can assign income and expense accounts to individual invoice items listed on the screen.
How Integration Works

- **Income Account**: The QuickBooks income account chosen here is assigned to the selected invoice item. By default, Other Income account is selected but you can choose any other Account Name from the drop-down list.

- **Expense Account**: The QuickBooks expense account chosen here is assigned to the selected invoice item. By default, Other Income account is selected but you can choose any other Account Name from the drop-down list.

Besides specifying accounts for invoice amount, taxes, retainers and discount, you can also select a different account for late fees. You can even skip sending the late fee invoices to QuickBooks by checking that option.

- **Do NOT Send Time and Expense Details**: You are given the option of not sending time and expense details for various invoices transferred from BillQuick to QuickBooks. You can check any contract type (such as Hourly, Percentage, Cost Plus, etc) or manual invoice for which you do not want to send time and expense details.

**Project Accounts**: When sending invoices to QuickBooks, BillQuick assigns accounts specified on the Invoices panel to the invoice items. You can override those accounts by assigning G/L accounts to invoice items on a project or project group basis.
How Integration Works

For the selected project or project group, each item on a BillQuick invoice like tax amount, discount, retainers, etc., can have a G/L account assigned to it. When you synchronize invoices with QuickBooks, the corresponding G/L account will be updated there.

- **Project/Project Group**: You can either select a project or a project group from the drop-down list to which the G/L accounts are assigned.

  ![Tip] If you assign accounts to a project group (say ‘ALL’), you no longer have to go back to Integration Settings screen every time you add a new project to that group. BillQuick will automatically assign these settings to the new project.

- **Accounts**: You can select QuickBooks accounts for each invoice item such as Service Amount, Service Tax Amount, Main Service Amount, Invoice Discount, Retainer, Late Fee, etc.

  ![Tip] Tax items should be assigned to liability accounts. E.g., Service Tax Amount can be assigned to Sales Tax Payable account and so on.

Payroll Settings

Every payroll item must be assigned to an account in QuickBooks. BillQuick allows you to assign QuickBooks payroll items and accounts to its time entry related items such as regular time, overtime, vacation, etc on an employee or employee group basis. The time data transferred will be assigned to the specified payroll item and account in QuickBooks.

- **Default Payroll Item**: You can specify a QuickBooks payroll item or wage type as the default payroll item. E.g. you may select Regular Pay or Salary as the default payroll type for BillQuick employees.

- **Payroll Expense Account**: You can specify a QuickBooks account for payroll expenses. By default, Payroll Expenses is selected but you can choose any other Expense Account from the drop-down list.
How Integration Works

- **Employee or Employee Group**: You can specify payroll items at the individual employee or employee group level. Choose the Payroll Items from the drop-down list for different BillQuick items, say Regular Time, Overtime, etc. Accordingly, the time data of the selected employee/employee group will be assigned to it.

  If you assign payroll items to an employee group (say 'ALL'), you no longer have to go back to Integration Settings screen every time you add a new employee to that group. BillQuick will automatically assign these settings to the new employee.

- **Payroll Items**: BillQuick’s time entry-related items (such as Regular Time, Overtime, Sick, Holiday, etc) can have a corresponding QuickBooks payroll item. You can select any QuickBooks payroll item from the drop-down list and assign it to the BillQuick items.
QuickBooks Class

QuickBooks sets up transaction entities called classes. These allow you to view financial statements and other accounting reports for the entity. It is a very useful feature when running accounting reports. If you keep data from multiple locations in one QuickBooks file, you may assign a ‘class’ to each location to facilitate pulling together similar items for reporting. Another example is tracking revenues and expenses by partner or service type. Each of these ‘classes’ would be assigned to a project that is owned by a partner or is the scope of work for a service type. You can run (for instance) a Profit and Loss Statement for that class, seeing only the service revenue and expenses associated with it.

After establishing connection between the two applications, you can transfer these classes from QuickBooks to BillQuick and assign them to items such as activities, expense codes and even projects. Classes can be assigned to projects, services, expense items or their groups. BillQuick allows you to assign a QuickBooks class to each transaction item that you wish to track.

⚠️ You need to assign QuickBooks class to BillQuick items before creating invoices and prior to the sync. Else, your class fields will remain blank in QuickBooks and will not display in reports.
How Integration Works

- **Assign Class to Projects:** Before transferring a project from BillQuick, you can assign a QuickBooks class to it. Select one or multiple projects from the grid and choose the desired class for it from the drop-down list. Else, assign a class to a Project Group. The assigned projects can be viewed in the timesheet of QuickBooks.

  ![](image)

  If you assign class to a project group (say ‘ALL’), you no longer have to go back to Integration Settings screen every time you add a new project to that group. BillQuick will automatically assign these settings to the new project. Same is true for the service and expense items.

- **Assign Class to Items:** Before transferring an expense or activity code from BillQuick, you can assign a QuickBooks class to it. Select one or multiple items from the grid and choose the desired class from the drop-down list. Else, assign a class to an Item Group.

  ![](image)

  See the [Initial Integration](#) section for step-by-step instructions.

If you have assigned classes to both projects and activities/expenses (or their groups), a project class gets precedence over an item class. For example, assign Class 1 to Project P1; and Class 2 to Activity A1, A2 and A3 and Expense E1, E2 and E3. If an invoice for Project P1 contains Activity A1 and Expense E1, BillQuick inserts Class 1 into the transaction for all items when it synchronizes the invoice with QuickBooks. In comparison, you may have an invoice for Project P2 with same activities (A1, A3) and expenses (E2, E3). In this case, when you synchronize the invoice, BillQuick adds Class 2 to the transactions for the activity and expense items.
If you are new to BillQuick as well as QuickBooks, initial integration tasks will be completed after you have set up your information in one or the other application.

Initial integration populates the BillQuick or QuickBooks company database with information from the other application. Your initial synchronization settings determine what information and how much of it is shared between the applications. For example, you may decide to move QuickBooks data for only the last two years to BillQuick.

For initial integration setup, you can specify synchronization options on the BillQuick-QuickBooks Integration Settings screen and then use the menus to transfer each type of data. You can do this by referring to the scenario best describing your needs, as discussed in Initial Integration section.

Alternatively, you could make use of QuickBooks Integration Wizard in BillQuick, which could be an easier and faster method for first-time integration. This wizard walks you through the process of specifying initial sync options, mapping of accounts and items, and finally the transfer of data between the two programs.

Please check Integration Rules for underlying rules and details about BillQuick-QuickBooks Integration.

QuickBooks Integration Wizard

The QuickBooks Integration Wizard is an easy-to-use tool for the first-time integration between BillQuick and QuickBooks. It walks you through the initial synchronization procedure and populates the BillQuick or QuickBooks database with available data. While the same task could be accomplished using the BillQuick-QuickBooks Integration Settings screen, the wizard is an easier and faster tool for many new users.

If you are trying to integrate a BillQuick Sample database with QuickBooks, you will be warned prior to the sync.

The steps involved in initial synchronization are:

1. Start BillQuick and open your Company database.
2. Access the wizard from the Integration menu, QuickBooks, QuickBooks Integration Wizard.


4. You will be prompted to choose a scenario that best describes your situation based on your usage of BillQuick and QuickBooks. You will be walked through a unique process depending upon the option chosen here.
5. In case of a New QuickBooks User, you need to create a new company file in QuickBooks. For those who have been using QuickBooks and/or BillQuick, you are prompted to back up your company files. Confirm that you made a backup copy of your QuickBooks and/or BillQuick company database, and then click Next.

From this point forward, if you have any trouble accessing your QuickBooks database it is most likely due to not being logged on to QuickBooks with administrative privileges.

6. Next, make sure QuickBooks application is running. You are prompted to open your QuickBooks application with administrative privileges in single user mode. Open the QuickBooks company file that you need to synchronize with.

7. In QuickBooks, grant access rights to BillQuick. See Security Permissions below for more.

8. In QuickBooks, all items (service items, expense items, invoice items) are associated with accounts. Please assign appropriate accounts to BillQuick items prior to sync. See Account Assignment for more information.

10. Next, the Wizard will allow you to select the desired BillQuick modules that will sync with QuickBooks. You can skip the data sync for any module.

![QuickBooks Integration Wizard]

Activity Codes in BillQuick can sync with Service Items in QuickBooks.

- I want to Send Activity Codes from BillQuick
- I want to Get Activity Codes from QuickBooks
- I don't want to Sync Activity Codes

When transferring employee data from QuickBooks, BillQuick assigns a default bill and cost rate of $1. However, if you want, you can enter different values in the Default Bill Rate and Default Cost Rate fields here (or later in the Employee screen).

When transferring time records from BillQuick to QuickBooks, you are given the option of not transferring compensation time by checking the ‘Do Not Transfer...’ option. Also, by default, the billable hours get transferred to QuickBooks. If you want actual hours to transfer instead, check the Transfer Hours option.

11. Now you will be asked to choose the type of data integration (sync mode) you want:

- On-Demand (allows you to sync when you want to)
- On-Schedule (allows you to schedule the synchronization process)
- Real-Time Synchronization (allows you to have immediate real-time sync)
12. If you select On-Demand sync, you will be able to sync the data in the next step. If you choose On-Schedule synchronization, you have to specify when you want to sync the data. You are provided with various Sync Options in the next screen.

13. To avoid data duplication in the case of existing users, the wizard attempts to find matching data and then link them. This is done using the Smart Match feature. If you want to skip auto-match for certain modules, un-check the appropriate box.

14. If the wizard fails to find a match automatically, you will be able to match it manually using the ‘Match Selected’ button. This is done by selecting the QB and BQ items from the grid and clicking the Match Selected.

You can even view the matched items by clicking the Show Matched button. Once done for all the un-matched items of various modules, click the Next button.

15. BillQuick is ready to sync with QuickBooks. A progress bar displays the status of the data transfer process. Your data sync is now completed!

For future data sync, you can set the integration preferences using the BillQuick-QuickBooks Integration Settings screen. See Integration Settings for more information.
Data integration is a process that transfers data between BillQuick and your accounting package. The first-time or initial integration brings the databases of the two applications to the same level. Your initial synchronization settings determine what information and how much of it is shared between the applications.

During integration set up and synchronization procedures, both BillQuick and QuickBooks must be running. For initial integration set up, you can specify synchronization options on the BillQuick-QuickBooks Integration Settings screen and then use the menu to transfer each type of data. You can do this by referring to the scenario best describing your needs, as discussed below.

**Security Permissions**

Before you synchronize BillQuick data with QuickBooks, you must have security permission to perform the task. The BillQuick Supervisor in your company assigns integration (and other) security rights to users. An easy way to avoid warning messages is to add BillQuick and QuickBooks to your Windows Startup folder so they run automatically at startup.

You also need to assign auto logon permission to BillQuick from QuickBooks. To allow direct communication, you have to grant permission to BillQuick to access your QuickBooks database.

1. Open QuickBooks application and log in with administrative privileges. Open the desired company file.

2. You will be prompted to grant access to BillQuick. Choose the ‘Yes, always allow access…’ option and click Continue.
3. Confirm your selection by clicking Done. This establishes the first connection between the two applications.

> By default, BillQuick always connects to the currently open QuickBooks company file. If QuickBooks is not running, it opens the file specified in the Integration Settings screen.

4. Select Edit menu, Preferences, Integrated Applications option.

5. Click on Company Preferences tab. Allow access to BillQuick application.

7. Assign the desired permissions for BillQuick. Click OK to save settings and then exit.

Please check Integration Rules before proceeding.
Scenario 1: Existing BillQuick-New QuickBooks User

BillQuick users who are new to QuickBooks start by transferring information from BillQuick to a new QuickBooks database. After creating the QuickBooks file and setting synchronization preferences, you can initiate synchronization and check the transferred data.

Please follow the steps below to integrate BillQuick and QuickBooks data.

1. QuickBooks Database

Before integrating data with BillQuick, a new QuickBooks user must first create a new QuickBooks database and assign permissions to BillQuick to access its data (see Security Permissions above).

1. Open QuickBooks and choose ‘Create a new company’. The EasyStep Interview starts and guides you in the process of creating a new company file.

2. Enter company name, address and other details.

3. Select your business type if you wish.

4. Enter the relevant information and exit from the wizard.
2. Backup Database

Before the initial sync, it is important to back up your BillQuick database. Select BackUp Database from the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the company database (for example, the standard installation folder \Program Files\BillQuick2011; \ = drive letter). If you want the database copy to be saved in another location, select Global Settings-Folders screen from the Settings menu and enter a new location.

3. Sync Settings

Specifying integration settings is necessary to define which data will be transferred as well as other preferences. Later, you can fine-tune these settings to control day-to-day integration process (see 5. Fine-Tune Synchronization Settings below).

1. Look at the status line at the bottom of the BillQuick screen. It displays the currently open BillQuick database. If it is not the one you want to integrate with, select File menu, Open Company. Choose the correct company and then continue to the next step.

2. From the Integration menu, select QuickBooks, Sync Settings. The BillQuick-QuickBooks Integration Settings screen displays.

3. On the left of the screen is a list of BillQuick modules, for both Send Settings and Get Settings. You can set various filters and other sync options based on the selected module.

   Since we want to transfer data from BillQuick to QuickBooks, ensure that the modules are selected from the Send Settings list. See Send Settings for more.
You only need to decide whether to send each type of BillQuick data to QuickBooks. If you wish to restrict what data records transfer to QuickBooks, choose one or more filters.

4. Click on the Account Assignment option and select default and other accounts for BillQuick items prior to data transfer. (See Account Assignment for more.) Click on the Save button and move on.
5. Next, select other sync settings on the left and make the desired assignments:

- Assign accounts to BillQuick invoice items (See Invoices for more information.)
- Specify QuickBooks accounts for BillQuick payroll items (See Payroll Settings for more.)
- Assign QuickBooks classes to BillQuick items (See QuickBooks Class for more information.)

6. Click the Save button to save all the sync settings and then exit.

4. Send Data

Now you are ready to send data from BillQuick to QuickBooks.

1. From the Integration menu in BillQuick, select QuickBooks, Send to QuickBooks.

2. In turn, select each menu item, starting with Employee. After the progress bar indicates that the transfer is complete, open the corresponding screens in BillQuick and QuickBooks and verify whether the data is complete. See Quick-Check for more information.
3. Repeat this step for the next menu item. Below are the BillQuick Send menu items and the corresponding QuickBooks screens.

<table>
<thead>
<tr>
<th>BillQuick Send Menu Item</th>
<th>QuickBooks Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee*</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendors*</td>
<td>Vendor</td>
</tr>
<tr>
<td>Client*</td>
<td>Customer</td>
</tr>
<tr>
<td>Project*</td>
<td>Job</td>
</tr>
<tr>
<td>Accounts</td>
<td>Chart of Accounts</td>
</tr>
<tr>
<td>Activity*</td>
<td>Service Item</td>
</tr>
<tr>
<td>Expense*</td>
<td>Other Charge Item</td>
</tr>
<tr>
<td>Time Entry</td>
<td>Time Tracking</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>Bills</td>
</tr>
<tr>
<td>Invoices</td>
<td>Invoices</td>
</tr>
<tr>
<td>Payments</td>
<td>Payments</td>
</tr>
</tbody>
</table>

* The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Labels feature.

Tip: In case of ‘Reimbursable’ expenses, you can send them to QuickBooks as bills via the Expense Log screen. BillQuick prompts you to define an Employee ID to Vendor ID switch.
5. Fine-Tune Synchronization Settings

After you check the data transferred to QuickBooks, you may wish to change your integration settings to ones better suited for day-to-day synchronization. See Day-to-Day Integration Scenarios for more.

Scenario 2: New BillQuick-Existing QuickBooks User

QuickBooks users who are new to BillQuick start by transferring information from QuickBooks to a new BillQuick database. After creating the BillQuick company file and setting synchronization preferences, you can initiate synchronization and check the transferred data.

Please follow the steps below to integrate BillQuick and QuickBooks data.

1. **BillQuick Company**

   Before integrating data, a new BillQuick user must first create a BillQuick company database. See BillQuick 2011 Help for more information.

   1. In BillQuick, select File menu, New Company. Choose the type of database technology you wish to use. If unsure, choose Standard.

      The database technology available to you depends on the BillQuick Edition purchased. If you are unsure what edition you licensed, select About BillQuick from the Help menu. The edition abbreviation displays right after the version number.

      | Edition           | Database Technology             |
      |-------------------|---------------------------------|
      | BillQuick Basic   | Microsoft Access (Standard)     |
      | BillQuick Pro     | Microsoft Access                |
      |                   | Microsoft SQL Express          |
      | BillQuick Enterprise | Microsoft Access            |
      |                   | Microsoft SQL Express          |
      |                   | Microsoft SQL Server           |

   2. On the New BillQuick Database dialog, enter a name for the new database. Most commonly, the company name is used for easy identification. Click the Open button. BillQuick creates the database and opens the BillQuick Start-Up Interview wizard.

      The BillQuick Start-Up Interview can be closed and reopened later. To do so, select Wizards, BillQuick Interview from the View menu.

   3. On the BillQuick Start-Up Interview panel, click the Next button.
4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity (service) and expense codes into your company database. These codes are not needed because items will transfer from QuickBooks into BillQuick. Click the Next button.

5. Custom Labels allow you to change key business terms to suit your professional and company preferences in BillQuick. Customizing terms eases transition from your old time and billing solution. Select your preferred terms from the drop-down lists. When done, click the Next button.

6. On the Company Name panel, enter your company name. Spell it exactly as it appears on your License and Registration (or Evaluation) Key email.

7. Click the Next button to accept the defaults on the remainder of the panels. You can update these options later in the Global Settings and User Preferences screen. On the last panel, click the Finish button.

8. The BillQuick Initial Setup Checklist wizard displays. It enables the first time user to create master information—employee, client, project, etc—confirming the actions using the checklists. When done, click the Close button.
9. Next, the Company screen displays. Enter the required data and click the Save button when done, or click the Close button and perform this task later.

10. From the File menu, select Login. For User ID, type ‘supervisor’ (without quotes), then for password, type ‘supervisor’ (without quotes). This gives you full security permissions in BillQuick to perform integration tasks.

2. Backup Database

Before the initial sync, it is important to back up your QuickBooks database. In QuickBooks, select ‘Save Copy or Backup’ from the File menu and then choose the ‘Backup copy’ option from that screen. Also, in QuickBooks you need to assign permissions to BillQuick to access its data (see Security Permissions above).
3. **Sync Settings**

Specifying integration settings is necessary to define which data will be transferred as well as other preferences. Later, you can fine-tune these settings to control day-to-day integration processing (see 5. *Fine-Tune Synchronization Settings below*).

1. Look at the status line at the bottom of the BillQuick screen. It displays the name of the BillQuick database that is open. If it is not the one you want to integrate with, select File menu, Open Company. Choose the correct company and then continue to the next step.

2. From the Integration menu, select QuickBooks, Sync Settings. The BillQuick-QuickBooks Integration Settings screen displays.

   ![Integration Settings](image)

   *See the Integration Settings section for more information.*

3. On the left of the screen is a list of BillQuick modules, both for Send Settings and Get Settings. You can specify various filters and other sync options based on the module selected.

   Since we want to transfer data from QuickBooks to BillQuick, ensure that the modules are selected from the Get Settings list. (See *Get Settings for more.*)
You only need to decide whether to get each type of QuickBooks data to BillQuick. If you wish to restrict what data records transfer from QuickBooks, choose one or more filters.

4. Click the Save button to save the sync settings and then exit.

4. Get Data

Now you are ready to get data from QuickBooks to BillQuick.

1. From the Integration menu in BillQuick, select QuickBooks, Get from QuickBooks.

2. In turn, select each menu item, starting with Employee. After the progress bar indicates that the transfer is complete, open the corresponding screens in BillQuick and QuickBooks and verify whether the data is complete. See Quick-Check for more information.
3. Repeat this step for the next menu item. Below are the BillQuick Get menu items and the corresponding QuickBooks screen.

<table>
<thead>
<tr>
<th>BillQuick Get Menu Item</th>
<th>QuickBooks Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee*</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendors*</td>
<td>Vendor</td>
</tr>
<tr>
<td>Client*</td>
<td>Customer</td>
</tr>
<tr>
<td>Project*</td>
<td>Job</td>
</tr>
<tr>
<td>Activity*</td>
<td>Service Item</td>
</tr>
<tr>
<td>Accounts</td>
<td>Chart of Accounts</td>
</tr>
<tr>
<td>Expense*</td>
<td>Other Charge Item</td>
</tr>
<tr>
<td>Estimates</td>
<td>Estimate</td>
</tr>
<tr>
<td>Expense Log</td>
<td>Bills/Checks</td>
</tr>
<tr>
<td>Time Entry</td>
<td>Time Tracking</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>Bills</td>
</tr>
<tr>
<td>Invoices</td>
<td>Invoices</td>
</tr>
<tr>
<td>Payments</td>
<td>Payments</td>
</tr>
</tbody>
</table>

* The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Labels feature.
5. Fine-Tune Synchronization Settings

Data touchup is needed in BillQuick after getting data from QuickBooks because BillQuick requires certain fields which might be optional in QuickBooks.

- When you get time entries from QuickBooks, make sure to update the bill and cost rates in BillQuick because QuickBooks doesn’t require them.
- Alt. Contact in QuickBooks corresponds to BillQuick’s Project Manager. If Alternate Contact is not specified in QuickBooks, BillQuick fills a placeholder ‘FromQuickBooks’ in the Project Manager field. Change that to the appropriate names.
- Check the IDs of records transferred from QuickBooks. You can change them, if desired, using Change/Merge IDs feature in BillQuick.
- Verify other data using the Aging Reports in BillQuick and QuickBooks. Note that credit memos in QuickBooks transfer to BillQuick as negative invoices and hence differences might occur in the aging reports.

After you check the data transferred to BillQuick, you may wish to change your integration settings to ones better suited to day-to-day synchronization. See Day-to-Day Integration Scenarios for more.

Scenario 3: New BillQuick-New QuickBooks User

If you are new to both BillQuick and QuickBooks, you need to set up databases in both applications for your company, enter and/or import master information in BillQuick (or QuickBooks), and then synchronize the data. The instructions below cover these tasks.

To gain the most complete and useful practice management information from the start and to reduce setup time, we recommend that you add or create master information and other time and billing data in your BillQuick database. The exception to this would be the chart of accounts and service and expense items, which should be created in QuickBooks and then transferred to BillQuick. Once data setup is done, you can sync data between BillQuick and QuickBooks.

BillQuick’s Import/Export function (Utilities menu) reads data in Comma Separated Value (comma delimited) or Tab Delimited files. In this utility, you can associate each data field with the corresponding one in BillQuick. If your old application exports data to a comma- or tab-delimited file format, or to Microsoft Excel (which can save data in these file formats), you can reduce setup time.

1. BillQuick Company Database

Before integrating, a new BillQuick user must create a BillQuick company database. BillQuick requires security permission to perform this task.

1. In BillQuick, select File menu, New Company. Choose the type of database technology you wish to use. If unsure, choose Standard.
The database technology available to you depends on the BillQuick edition purchased. If you are unsure what edition you licensed, select About BillQuick from the Help menu. The edition abbreviation displays right after the version number.

<table>
<thead>
<tr>
<th>Edition</th>
<th>Database Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>BillQuick Basic</td>
<td>Microsoft Access (Standard)</td>
</tr>
<tr>
<td>BillQuick Pro</td>
<td>Microsoft Access</td>
</tr>
<tr>
<td></td>
<td>Microsoft SQL Express</td>
</tr>
<tr>
<td>BillQuick Enterprise</td>
<td>Microsoft SQL Express</td>
</tr>
<tr>
<td></td>
<td>Microsoft SQL Server</td>
</tr>
</tbody>
</table>

2. On the New BillQuick Database dialog, enter a name for the new database. Most commonly, the company name is used for easy identification. Click the Open button. BillQuick creates the database and opens the BillQuick Start-Up Interview wizard.

The BillQuick Start-Up Interview can be closed and reopened later. To do so, select BillQuick Interview from the View menu, Wizards.

3. In the BillQuick Start-Up Interview panel, click the Next button.

4. For the Business Type, you would select a type if you want BillQuick to copy default industry-specific activity (service) and expense codes into your company database. If you wish to use your own set of codes, leave the field blank and click the Next button.

5. Custom Labels allow you to modify key business terms to match your profession and company-preferred terminology in BillQuick. Customizing terms eases transition from your old time and billing solution. If you selected a business type on the previous panel, common terms or custom labels display for your profession. If you left business type blank, these fields will be blank as well. To select a BillQuick label to change, click the drop-down. When done, click the Next button.

6. On the Company Name panel, enter your company name. Type it exactly as it appears on your License and Registration (or Evaluation) Key email.
7. Click the Next button to accept the defaults on the remainder of the panels. You can update these options later on the Global Settings and User Preferences screens. On the last panel, click the Finish button.

8. The BillQuick Initial Setup Checklist wizard displays. This wizard enables the first time user to create master information—employee, client, project, etc—confirming the actions using the checklists. When done, click the Close button.
9. Next, the Company screen displays. Enter required data and click the Save button when done, or click the Close button and perform this task later.

10. From the File menu, select Login. For User ID, type ‘supervisor’ (without quotes), then for password, type ‘supervisor’ (without quotes). This gives you full security permissions in BillQuick to perform integration tasks.

2. QuickBooks Database

Before integrating, a new QuickBooks user must create a QuickBooks database and assign permission to BillQuick to access its data (see Security Permissions for more).

1. Open QuickBooks and choose ‘Create a new company’. The EasyStep Interview starts and guides you in the creation of a new company file.

2. Enter company name, address and other details.
3. Select your business type.

4. If you wish, enter the relevant information and then exit from the wizard.

3. Set Up Data

Setting up data may be a manual process, utilize imported data, or a combination of both. The sequence for efficient setup is as follows:

1. Master information should be set up first in BillQuick (from the View menu). This includes Employee, Projects, Clients, Activity Codes, etc. If you have subcontractors or consultants for whom you record time or expenses, then set up Vendors also. Other types of master information can be added later.

When setting up new records, you only need to enter data into a few required fields. All required fields have **BLUE** labels. Other data can be entered now or later.

<table>
<thead>
<tr>
<th>BillQuick Setup Sequence</th>
<th>BillQuick Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees</td>
<td>Employee*</td>
</tr>
<tr>
<td>Vendors</td>
<td>Vendor*</td>
</tr>
<tr>
<td>Activities</td>
<td>Activity Codes*</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Codes*</td>
</tr>
<tr>
<td>Clients</td>
<td>Client*</td>
</tr>
<tr>
<td>Projects</td>
<td>Project*</td>
</tr>
<tr>
<td>Time Entries</td>
<td>Time Entry*</td>
</tr>
<tr>
<td></td>
<td>(Sheet View)</td>
</tr>
<tr>
<td>Expense Entries</td>
<td>Expense Log</td>
</tr>
<tr>
<td>Invoices</td>
<td>Invoice Review</td>
</tr>
<tr>
<td>Payments</td>
<td>Payment</td>
</tr>
</tbody>
</table>

* The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Labels feature.

The exception to this would be the activity and expense codes (service and expense items), which should be created in QuickBooks and then transferred to BillQuick.

2. Create or add project records in BillQuick. The term ‘project’ may be changed in BillQuick to Engagement, Matter, Job, Work Order or another term you prefer. Phases, segments and sub-segments can be created to break down work being done for a client.

Each project record contains contract, billing arrangement, budget, special billing rate, and other elements that control how BillQuick adapts to your company and processes data. When billing, BillQuick automatically organizes information by project (with the option to create one invoice per project or one invoice for all of a client’s projects), making it easier and faster to bill clients. Also, practice management information is more detailed and readily available by project.
An accountant, for instance, may deliver tax, payroll and consulting services to a client, each billed differently (fixed fee, recurring monthly fee, hourly), and possibly, at different bill rates for the same employees doing the work. An attorney may handle contract, litigation, real estate, and other matters to a client, and again elements of the relationships may vary. Architects and engineers often break down projects into phases, assigning a portion of the contract amount and/or budget to the phase of work.

3. Create a chart of accounts in QuickBooks to describe and monitor the financial activity of your business. You can create these accounts from scratch or use the standard chart of accounts provided by QuickBooks.

4. Determine what time records (e.g. timesheets, daily diaries, time entries in your old time and billing application) and expenses (e.g. expense reports) are unbilled. Manually enter or import these records into BillQuick.

   Before entering time records, review each employee record in BillQuick to make sure the Bill Rate and Cost Rate is correct. Also, if special bill rates (and cost rates) apply to work done by employees on a project, be sure to define an appropriate Service Fee Schedule and assign it to related projects before entering time records. BillQuick uses these rates to calculate the bill amount and cost amount of time records.

   To manually enter time records, select Sheet View or Simple Time Card from the Time-Expense menu. Each time record for an employee requires a date, project to be charged, activity code and hours. A memo or extended note is optional.

   BillQuick supports Control Hours. To activate the feature, check the option on the Sheet View screen. It warns you if the total hours entered during a session are different from the control hours specified.

   To manually enter expense records into BillQuick, select Expense Log or Simple Expense Log from the Time-Expense menu. Each expense record for an employee requires a date, project to be charged, expense code, units, and as needed, cost and markup (when a default is not part of the expense code). A memo or extended note is optional.

5. When recording old invoices in BillQuick, you have several options:

   - ‘Project’ detailed invoices – previous project invoices sent to clients. You can enter only outstanding (unpaid) invoices or invoices going back as long as you want practice management information available. See A below.
   - ‘Client’ detailed invoices – previous invoices sent to a client for all work done which is not broken down by project. See B below.
   - Balance forward invoices – summary amount by client for all outstanding invoices. See C below.

A. To enter detailed invoices by project . . .

   - Select Manual Invoice from the Billing menu.
Initial Integration

- Select the ID of the project to which the invoice applies.
- In the Description field, enter a brief description or explanation for the services billed in your old system and the total for the services from the old invoice. On the next line, do the same for expenses and check the Exp option.
- Verify that Amount Due at the bottom of the screen matches the old invoice.
- Click the Process button.
- Repeat for each detailed project invoice.

B. To enter detailed invoices by client . . .

- Open the Project screen from the Project menu.
- Click the New button.
- Enter a unique Project ID that identifies the project record as existing only for detailed client invoices. Fill in the required fields and click the Save button.
- Click the Clone button and select the ID of the project you just defined from the drop-down list. Check the ‘Clone for Selected Clients’ option, and select the clients for whom you want to add detailed client invoices. Click the OK button and close the Project screen.
- Select Manual Invoice from the Billing menu.
- Select the ID of the first ‘client invoices’ project.
- In the Description field, enter a brief description or explanation for the services and the total amount for all services from the old invoice. On the next line, do the same for expenses and check the Exp box.
- Verify that Amount Due at the bottom of the screen matches the old invoice.
- Click the Process button.
- Repeat for each detailed client invoice.

C. To enter balance forward invoices by client . . .

- Open the Project screen from the Project menu.
- Click the New button.
- Enter a unique Project ID that identifies the project as existing only for balance forward amounts. Fill in the other required fields and click the Save button.
- Click the Clone button, select the ID of the project you just defined from the drop-down list, check the ‘Clone for Selected Clients’ option, and select the clients for whom you want to add balance forward amounts. Click the OK button. Close the Project screen.
- Select Manual Invoice from the Billing menu.
- Select the ID of the first ‘balance forward’ project.
- In the Description field, enter a brief description such as ‘Balance Forward for Client ABC’ and the total services amount for all outstanding invoices. On the next line, do the same for expenses and check the Exp box.
- Verify that Amount Due at the bottom of the screen matches the summary balance.
- Click the Process button.
- Repeat the above steps for each balance forward invoice.

6. If you entered any paid invoices, you need to record the associated payment (cash receipt) to bring it to the ‘paid’ status in BillQuick. Select Payments from the Billing menu and record cash
receipts, credit memos, and other items for each invoice. Retainer amounts and amounts on account can also be recorded on the Payment screen, either to the client or to a specific project.

If you entered only outstanding invoices or balance forward amounts, you can move to the next step.

4. **Sync Settings**

After data has been set up in the respective applications, you need to sync it. You can start by transferring the QuickBooks data into BillQuick (chart of accounts and service and expense items). As the rest of the data is in BillQuick, you will have to transfer that to QuickBooks so that both applications begin processing from the same point onwards. Specifying sync settings is necessary to define which data will be transferred as well as other preferences. Later, you can fine-tune these settings to control day-to-day integration (see 9. *Fine-Tune Synchronization Settings below*).

1. Look at the status line at the bottom of the BillQuick screen. It displays the name of the currently open BillQuick database. *If it is not the one you want to integrate with*, select File menu, Open Company. Choose the correct company and then continue to the next step.

2. Start QuickBooks and open the database that you wish to integrate with BillQuick.


   ![Integration Settings Screen](image)

   *See the Integration Settings section for more information.*

4. On the left of the screen is a list of BillQuick modules for both Send Settings and Get Settings. You can specify various filters and other sync options based on the module selected here.
Initial Integration

First, we want to transfer data (activity, expense items, chart of accounts) from QuickBooks to BillQuick. Ensure that these modules are selected from the Get Settings list. (See Get Settings in the Integration Settings section for more.)

5. Click on the Save button to save the sync settings and then exit.

5. Get Data

Now you are ready to get data from QuickBooks to BillQuick.

1. From the Integration menu in BillQuick, select QuickBooks, Get from QuickBooks.

2. In turn, select your menu item, starting with Employee. After the progress bar indicates that the transfer is complete, open the corresponding screens in BillQuick and QuickBooks and verify whether the data is complete. See Quick-Check for more information.

6. Fine-Tune Synchronization Settings

Data touchup is needed in BillQuick after getting data from QuickBooks because BillQuick requires certain fields which might be optional in QuickBooks. In this case,
Initial Integration

- Check the IDs of records transferred from QuickBooks. You can change them, if desired, using Change ID Codes feature in BillQuick.
- Check the accounts transferred along with the service and expense items in the Activity Codes and Expenses Codes screen, respectively.

7. Send Settings

Since our next step is to transfer the rest of the data from BillQuick to QuickBooks, you have to specify Send Settings in the BillQuick-QuickBooks Integration Settings screen. You also need to specify accounts, payroll settings and QuickBooks classes for BillQuick items prior to the sync.

See the Integration Settings section for more information.

1. Again open the BillQuick-QuickBooks Integration Settings screen.

Since we want to transfer data from BillQuick to QuickBooks, ensure that the module names are selected from the Send Settings list. (See Send Settings for more.)
You only need to decide whether to send each type of BillQuick data to QuickBooks. If you wish to restrict what data records transfer to QuickBooks, choose one or more filters.

2. Click the Account Assignment option and select default and other accounts for BillQuick items. (See **Account Assignment** for more.) Click the Save button and move on.

3. Next, select other sync settings on the left and make the desired assignments:
   - Assign accounts to BillQuick invoice items (See **Invoices** for more information.)
   - Specify QuickBooks account for BillQuick payroll items (See **Payroll Settings** for more.)
   - Assign QuickBooks classes to BillQuick items (See **QuickBooks Class** for more information.)

4. Click on the Save button to save all the sync settings and then exit.
8. Send Data

Now you are ready to synchronize data with QuickBooks.

In case of a BillQuick Sample database, the user is warned before the sync.

1. From the Integration menu in BillQuick, select QuickBooks, Send to QuickBooks.

2. In turn, select each menu item, starting with Employee. After the progress bar indicates that the transfer is complete, open the corresponding screens in BillQuick and QuickBooks and verify whether the data is complete. See Quick-Check for more information.

3. Repeat this step for the next menu item. Below are the BillQuick Send menu items and the corresponding QuickBooks screen.

<table>
<thead>
<tr>
<th>BillQuick Send Menu Item</th>
<th>QuickBooks Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee*</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendors*</td>
<td>Vendor</td>
</tr>
<tr>
<td>Client*</td>
<td>Customer</td>
</tr>
<tr>
<td>Project*</td>
<td>Job</td>
</tr>
<tr>
<td>Time Entry</td>
<td>Time Tracking</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>Bills</td>
</tr>
<tr>
<td>Invoices</td>
<td>Invoices</td>
</tr>
<tr>
<td>Payments</td>
<td>Payments</td>
</tr>
</tbody>
</table>

* The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Labels feature.
In case of ‘Reimbursable’ expenses, you can send them to QuickBooks as bills via the Expense Log screen. BillQuick prompts you to define an Employee ID to Vendor ID switch.

9. Fine-Tune Synchronization Settings

After you check the data transferred to QuickBooks, you may wish to change your integration settings to ones better suited to day-to-day synchronization. See Day-to-Day Integration Scenarios for more.

Scenario 4: Existing BillQuick-Existing QuickBooks User

Typically, a company utilizes BillQuick to manage projects, enter time, generate invoices, record payments, and produce reports. QuickBooks is utilized for accounting tasks such as payroll, accounts payable, financial reports and so on. If you have been using both BillQuick and QuickBooks, and want the two applications to be able to share data, you need to develop a proper integration plan. This plan should take into consideration what data (if any) has been transferred between the applications in the past, either manually or via Import/Export facility. Based on this, your initial integration steps may vary.

1. Open Database

Since you have data in both BillQuick and QuickBooks, you need to open both applications. Ensure that the company databases that you wish to synchronize are open.

2. Backup Data

Next, back up both BillQuick and QuickBooks databases.

To back up the BillQuick Database, select BackUp Database from the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the company database (for example, the standard installation folder \Program Files\BillQuick2011; x = drive letter). If you want the database copy to be saved in another location, select Global Settings-Folders screen from the Settings menu and enter a new location.

In QuickBooks, select Backup from the File menu and then choose a backup option from the ‘Save Copy or Backup’ screen. Also, in QuickBooks you need to assign permission to BillQuick to access its data (see Security Permissions for more). You need to be logged in with administrative privileges and in single user mode to be able to do that.

3. Sync Settings

Existing users have the option to send and get data as per their needs and business practice. What data is to be transferred depends on how you have been previously keeping your data in both applications. Some of the records being transferred between the two may already be present in the other database. In this case, the duplicates need to be merged.
1. Open the BillQuick application.

2. Look at the status line at the bottom of the BillQuick screen. It displays the currently open BillQuick database. If it is not the one you want to integrate with, select File menu, Open Company. Choose the correct company and then continue to the next step.

3. Start QuickBooks and open the database that you wish to integrate with BillQuick.


See the Integration Settings section for more information.

5. On the left is a list of modules, both for Send Settings and Get Settings. You can specify various filters and other options based on the module selected.

Determine what data you want to get from QuickBooks and what data to move into QuickBooks. Accordingly, select the module from the send or get list. (See Send Settings or Get Settings for more.)
You should send approved time entries to QuickBooks only if you do payroll in QuickBooks.

If you have created invoices and payments in QuickBooks only, you should move the clients, projects and employees from BillQuick to QuickBooks. Once these records are moved, you can then link the QuickBooks invoices and payments to these projects (jobs).

6. Click the Account Assignment option and select default and other accounts for BillQuick items. (See Account Assignment for more.) Click on the Save button and move on.
6. Next, select other sync settings on the left and make the desired assignments:

   - Assign accounts to BillQuick invoice items (See Invoices for more information.)
   - Specify QuickBooks account for BillQuick payroll items (See Payroll Settings for more.)
   - Assign QuickBooks classes to BillQuick items (See QuickBooks Class for more information.)

7. Click on the Save button to save all the sync settings and then exit.

4. Sync Data

Now you are ready to synchronize data between BillQuick and QuickBooks.

   If you are trying to integrate a BillQuick Sample database with QuickBooks, you will be warned prior to the sync.
In case of ‘Reimbursable’ expenses, you can send them to QuickBooks as bills via the Expense Log screen. BillQuick prompts you to define an Employee ID to Vendor ID switch.

1. From the Integration menu in BillQuick, select the appropriate Send to QuickBooks or Get from QuickBooks option.

2. In turn, select each menu item, starting with Employee. After the progress bar indicates that the transfer is complete, open the corresponding screens in BillQuick and QuickBooks and verify whether the data is complete. See Quick-Check for more information.

3. Repeat this step for the next menu item. Below are the BillQuick Send/Get menu items and the corresponding QuickBooks screen.

<table>
<thead>
<tr>
<th>BillQuick Menu Item</th>
<th>QuickBooks Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee*</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendors*</td>
<td>Vendor</td>
</tr>
<tr>
<td>Client*</td>
<td>Customer</td>
</tr>
<tr>
<td>Project*</td>
<td>Job</td>
</tr>
<tr>
<td>Accounts</td>
<td>Chart of Accounts</td>
</tr>
<tr>
<td>Activity*</td>
<td>Service Item</td>
</tr>
<tr>
<td>Expense*</td>
<td>Other Charge Item</td>
</tr>
<tr>
<td>Estimate</td>
<td>Estimate</td>
</tr>
<tr>
<td>Expense Log</td>
<td>Bill/Checks</td>
</tr>
<tr>
<td>Time Entry</td>
<td>Time Tracking</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>Bills</td>
</tr>
<tr>
<td>Invoices</td>
<td>Invoices</td>
</tr>
<tr>
<td>Payments</td>
<td>Payments</td>
</tr>
</tbody>
</table>

* The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Labels feature.
5. Match Data

In case of existing BillQuick and QuickBooks users, it is likely that duplicate records are found in the other application. This duplication arises because of separate entry of data in the two applications, even for similar records. The matching of these records can be a time consuming process. However, you need to do it only once and then from that point onwards, data sync can be scheduled accordingly. To save time, you can skip matching of inactive records.

During data sync process, BillQuick will either overwrite the duplicate data or leave it as is, depending upon the Overwrite Rules specified in the BillQuick-QuickBooks Integration Settings screen. You can manually check and merge the duplicate data in any of the applications. The records that were moved from BillQuick to QuickBooks should stay and the QuickBooks records can be deleted after sync. The main reason for keeping the BillQuick-created records is that BillQuick maintains a link between the two applications after the first sync. This QBLinkID helps to update the two records in the future.

Alternatively, you can make use of BillQuick’s Smart Match feature to link similar records or unlink different records. With this feature, BillQuick attempts to find matching data (both active as well as inactive) and link them automatically. If it fails to find a match, you can match it manually. You can even skip auto-match for certain modules, if desired. You can view both BillQuick and QuickBooks data on the BillQuick<->QuickBooks Smart Match screen.

When you restore a backup copy of the QuickBooks (or BillQuick) database, the links between BillQuick and QuickBooks may not be complete or accurate. You need to run Smart Match to match up existing records and then sync the remaining records. This may occur when a current
copy of the database is damaged and replaced with a backup copy. It may also occur when you send a backup copy of QuickBooks to your accountant who makes changes to it and then that database is restored. QuickBooks re-indexes the records, thus breaking all the links with BillQuick.

Depending upon the option selected in the Data field on the button panel, the data records will be displayed in grids, separately for BillQuick and QuickBooks. E.g., if you select Employees in the Data field, you can view employee data already matched between the two applications on the Matched tab. The grid will display BillQuick records and corresponding matched QuickBooks records. If needed, you can select the matched records and then un-match them using the UnLink button. Similarly, on the Unmatched tab, you will see unmatched data between the two applications. If needed, you can select the unmatched records and then match them using the Link button. You can also choose to auto-match the unmatched records by checking that option.

6. Fine-Tune Synchronization Settings

Data touchup is needed in BillQuick after getting data from QuickBooks because BillQuick requires certain fields which might be optional in QuickBooks.

- When you get time entries from QuickBooks, make sure to update the bill and cost rates in BillQuick because QuickBooks doesn’t require them.
- Alt. Contact in QuickBooks corresponds to BillQuick’s Project Manager. If Alternate Contact is not specified in QuickBooks, BillQuick fills a placeholder ‘FromQuickBooks’ in the Project Manager field. You can change those to the appropriate names.
- Check the IDs of the records got from QuickBooks. You can change them, if desired, using Change ID Codes feature in BillQuick.
- Verify other data using the Aging Reports in BillQuick and QuickBooks. Note that credit memos in QuickBooks transfer to BillQuick as negative invoices and hence differences might occur in the aging reports.

After you check the data transferred to/from QuickBooks, you may wish to change your integration settings to ones better suited to day-to-day synchronization. See Day-to-Day Integration Settings for more.
Quick-Check

A standard procedure after initial synchronization of data between BillQuick and QuickBooks is to check the transferred data. This ensures that your information is accurate and complete.

BillQuick creates a log that lists all records that were transferred from/to QuickBooks. This log file contains information such as month and year of sync and more than just the exceptions.

BillQuick contains multiple processes to ensure accurate and complete transfer of data. However, you may find that a setting in QuickBooks may have restricted the transfer of some data. Or, you may have inadvertently checked filters on the BillQuick-QuickBooks Integration Settings screen. Checking data before you begin normal processing ensures no surprises later.

After synchronizing data, go to the section below and follow the suggested instructions.

1. **Check Employees**

Check the data that exists in BillQuick and QuickBooks to ensure that data transfer has occurred as planned.

**Detailed Checking**

1. In QuickBooks, select Employee Center from the Employees menu or the toolbar.
2. In BillQuick, select Employees from the View menu.
3. Switch between the applications, selecting the same employee in both screens and checking whether the data is same.

**Before entering time records, or transferring time records from QuickBooks,** review each employee record in BillQuick to make sure the Bill Rate and Cost Rate are correct. Also, if special bill rates (and special cost rates) apply to work done by employees on a project, be sure to define an appropriate Service Fee Schedule and assign it to related projects before entering or transferring time records. BillQuick uses these rates to calculate the bill amount and cost amount of time records.

**Summary Checking**

As part of the integration function, BillQuick provides QuickBooks Sync Reports. Acting as audit reports to verify transfer of information, the reports show which records are linked and unlinked in both BillQuick and QuickBooks. Optional filters allow you to precisely identify the information you want to view:

1. Open a report from the Integration menu, QuickBooks, QuickBooks Sync Reports. E.g., ‘Employees Synced with QuickBooks’ report.


3. Preview the report. The list of BillQuick employees synced with QuickBooks is displayed.
Quick Check

See BillQuick Help, BillQuick<->QuickBooks Integration for more about QuickBooks Sync Reports.

2. Check Vendors

Repeat the above process for vendor data. Use the Detailed Checking or Summary Checking method.

For detailed checking, in QuickBooks select Vendors menu, Vendor Center. In BillQuick, select View menu, Vendors. Compare the vendor list in both screens.

For summary checking, in BillQuick, select Integration menu, QuickBooks, QuickBooks Sync Reports and open the ‘Vendors Synced with QuickBooks’ report.

On the BillQuick Vendor screen, determine which of the vendors transferred from QuickBooks (if any) should be deleted. Select the vendor from the grid, verify you selected the correct vendor and click the Delete button.

If you enter time records for vendors (subcontractor or consultants) in BillQuick, be sure to change the Bill and Cost Rates. When transferred from QuickBooks, BillQuick inserts $0 as placeholder values in vendor records.

3. Check Activity and Expense Codes

Repeat the above process activities and expense codes. Use the Detailed Checking or Summary Checking method.

For detailed checking, in QuickBooks select Lists menu, Item List. In BillQuick, select View menu, Activity Codes (or Expense Codes). Compare the activity list (or expense list) in both screens.

For summary checking, in BillQuick, select Integration menu, QuickBooks, QuickBooks Sync Reports and open the ‘Service Items Synced with QuickBooks’ (or ‘Expense Items Synced with QuickBooks’) report.

4. Check Clients/Customers

Repeat the above process. Use the Detailed Checking or Summary Checking method.

For detailed checking, in QuickBooks select Customers menu, Customer Center. In BillQuick, select View menu, Client. Compare the client list in both screens.

For summary checking, in BillQuick, select Integration menu, QuickBooks, QuickBooks Sync Reports and open the ‘Clients Synced with QuickBooks’ report.

5. Check Projects/Jobs

Repeat the above process. Use the Detailed Checking or Summary Checking method.

For detailed checking, in QuickBooks select Customers menu, Customer Center. In BillQuick, select Project menu, Project Information. Compare the project list in both screens.
Quick Check

For summary checking, in BillQuick, select Integration menu, QuickBooks, QuickBooks Sync Reports and open the ‘Projects Synced with QuickBooks’ report.

---

Special Note

BillQuick is project-centric. Each project is associated with a client. Time and expenses are charged to a project, and bills are generated by project (though multiple bills can appear on a joint invoice).

In QuickBooks, you may have billed customers rather than jobs (projects). If so, no projects appear in BillQuick because there are no jobs to transfer. Similarly, if you billed some jobs and some customers, only the existing jobs transfer to BillQuick.

However, BillQuick automatically creates projects on-the-fly when you transfer customer invoices from QuickBooks. The Project ID is based on the Customer ID. Also, because Project Manager is a required field in BillQuick, and there is no corresponding field in QuickBooks, BillQuick creates a new employee record with placeholder values, ‘FromQuickBooks’. This maintains data integrity in BillQuick. You can decide who is responsible for each project/job later.

**Bottom Line:** You may need to repeat this quick-check step after synchronizing QuickBooks invoices to BillQuick.

---

6. Check Time Entries

Repeat the above process for time entries. Use the Detailed Checking or Summary Checking method.

For detailed checking, in QuickBooks select Enter Time (Use Weekly Timesheet) from the Employees menu or Customers menu. In BillQuick, select Time-Expense menu, Sheet View. Compare the time entries in both screens.

For summary checking, in BillQuick, select Integration menu, QuickBooks, QuickBooks Sync Reports and open the ‘Time Entries Synced with QuickBooks’ report.

---

7. Check Expense Entries

Repeat the above process for expense entries. Use the Detailed Checking or Summary Checking method.

For detailed checking, in QuickBooks select Enter Bills from the Vendors menu. In BillQuick, select Time-Expense menu, Expense Log. Compare the expenses entries in both screens.

For summary checking, in BillQuick, select Integration menu, QuickBooks, QuickBooks Sync Reports and open the ‘Expenses Synced with QuickBooks’ report

📖 See BillQuick Help, BillQuick↔QuickBooks Integration for more about QuickBooks Sync Reports.
8. Check Invoices

Repeat the above process for invoices. Use the Detailed Checking or Summary Checking method.

For detailed checking, open the Create Invoices screen from the Customers menu in QuickBooks. In BillQuick, select Invoice Review from the Billing menu. Compare the invoices in both screens.

For summary checking, open the ‘Invoices Synced with QuickBooks’ report in BillQuick from the Integration menu, QuickBooks, QuickBooks Sync Reports.

See BillQuick Help, BillQuick↔QuickBooks Integration for more about QuickBooks Sync Reports.

9. Check Payments

Repeat the above process for payments. Use the Detailed Checking or Summary Checking method.

For detailed checking, open the Receive Payments screen from the Customers menu in QuickBooks. In BillQuick, select Payments from the Billing menu. Compare the payments in both screens.

For summary checking, open the ‘Payments Synced with QuickBooks’ report in BillQuick from the Integration menu, QuickBooks, QuickBooks Sync Reports.

If a user transfers credit memos from QuickBooks to BillQuick, the Aging report in BillQuick displays information without considering the credit memo data. To view aging report with this data, use the Aging with Overpayments report.

Please check the Integration Rules for underlying rules and details about BillQuick↔QuickBooks Integration.
Day-to-Day Integration Settings

After completing initial synchronization, review current settings to determine if they should be fine-tuned for day-to-day integration.

It is a good practice to maintain clients, projects, time and expenses, billing, accounts receivables, payments and reports in BillQuick. QuickBooks should be used for functions such as accounts payable, general ledger, banking, payroll and financial statements. The following illustration gives an idea about the common breakdown of tasks you should be doing in BillQuick and QuickBooks.

Below are situations to consider for each type of data and also the best practices followed in the industry.

Please check the Integration Rules for underlying rules and details about BillQuick<>QuickBooks Integration.

Master Information

Consider where you want to save each type of master information – activity codes, expense codes, employees, clients, and projects. When you add, edit or delete records, do you want this task done in BillQuick, in QuickBooks, or both?
Commonly, companies maintain project records in BillQuick only. This is the core information essential to effective practice management and maintaining it in BillQuick is appropriate. Hence, it is better to create and maintain that data in BillQuick and send it to QuickBooks.

However, it is a good practice to create activity and expense (other charge) items in QuickBooks because appropriate G/L accounts are assigned to them there. It is easier to transfer these items into BillQuick along with their G/L accounts. To enforce this policy, you should accordingly ‘turn on’ getting this data from QuickBooks. This can be done in the BillQuick→QuickBooks Integration Settings screen by selecting the desired module and un-checking the ‘Do Not Get’ option.

Where you maintain client (customer) records depends on your situation.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Sync Setting</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require extensive customer information (e.g. sales and payment defaults)</td>
<td>From Send Settings list, select Client and check the ‘Do Not Send’ box.</td>
<td>Maintain customer records in QuickBooks. Get updated records from QuickBooks as needed.</td>
</tr>
<tr>
<td>Require typical customer information</td>
<td>From the Get Settings list, select Client and check the ‘Do Not Get’ box</td>
<td>Maintain client records in BillQuick. Send updated records to QuickBooks as needed.</td>
</tr>
<tr>
<td>Desire convenience of update data common to BillQuick and QuickBooks, or want to enter data in either system</td>
<td>From the Send Settings and Get Settings list, select Client and make sure both ‘Do Not…’ boxes are unchecked.</td>
<td>Synchronize as needed.</td>
</tr>
</tbody>
</table>

Decisions about employees follow a similar process.

**Time Records**

You can record all time entries in BillQuick or one of its add-on modules and then send it to QuickBooks via integration. Whether you transfer time records from QuickBooks or not, time entries from employees (and vendors/consultants) should be entered in BillQuick. It is designed for maximum data entry efficiency and maximum flexibility (4 built-in ways to manage time, plus 5 ways to capture your hours remotely). BillQuick also includes numerous time and expense/work-in-progress reports.

If you do payroll through QuickBooks, you would send time records to QuickBooks. Make sure the ‘Do Not Send’ box for Time Entry is unchecked for Send Settings option in BillQuick-QuickBooks Integration Settings screen. BillQuick Time Entries become QuickBooks Time Tickets.

If payroll is not done through QuickBooks, then there is no reason to send time entries to it. Check the ‘Do Not Send’ option for time entries.

**For payroll done using other applications, you can export time entries using BillQuick’s Import/Export feature (Utilities menu).**
When you integrate with QuickBooks, a flag can be associated with a payroll item. For example, if you track hours as well as piecework in BillQuick and pass both types of hours to QuickBooks, the hourly work might be associated with the Regular Pay payroll item and piece work with the Piece Rate payroll item. Whether time entries flow to QuickBooks, depends on your situation.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use hours to process payroll</td>
<td>Transfer time entries to QuickBooks. Block time entries flowing from QuickBooks into BillQuick.</td>
</tr>
<tr>
<td>Do not use hours to process payroll</td>
<td>Do not transfer time entries to QuickBooks. Block time entries flowing from QuickBooks into BillQuick.</td>
</tr>
<tr>
<td>Use hours for special analysis</td>
<td>Determine whether you analyze time (a) as a custom BillQuick report, (b) when exported to Excel, or (c) through QuickBooks. If (c) then follow the first suggestion above.</td>
</tr>
</tbody>
</table>

However, there are some integration rules that limit the re-sending of the same time data to QuickBooks. For example, if you send a time entry to QuickBooks (say for 40 hours) and then change it in BillQuick, it cannot be re-sent as it creates duplicate hours. Even if you delete it in QuickBooks, it cannot be re-sent from BillQuick because it has already established a Link ID for it.

You may send BillQuick time records to QuickBooks by selecting the Send to QuickBooks option from the right-click menu in Sheet View.

**Expenses**

You can record expenses in BillQuick or QuickBooks. There is no duplication of data involved in the integration process between BillQuick and QuickBooks. However, QuickBooks does not accept negative expenses. To transfer expenses to/from BillQuick, make sure the Do Not Get/Send box for Expenses is used accordingly.

💻 If you send invoices with negative line items from BillQuick, the total of all line items has to be positive for data transfer to QuickBooks.

Whether you process reimbursable expenses to employees (e.g., travel, mileage) and other items chargeable to project (e.g., vendor invoices, materials) in BillQuick or in QuickBooks depends on the accounting software you use and your company procedures.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record employee and vendor expenses in BillQuick</td>
<td>1. Enter expenses in Expense Log. Mark the ‘R’ box.</td>
</tr>
<tr>
<td></td>
<td>2. Review and approve expenses. Adjust markups and charge amounts as needed.</td>
</tr>
<tr>
<td></td>
<td>3. Synchronize the expenses with QuickBooks. Employee IDs convert to Vendor IDs.</td>
</tr>
<tr>
<td></td>
<td>4. Cut checks for employee and vendor reimbursements when ready.</td>
</tr>
<tr>
<td>Record employee and vendor expenses in QuickBooks</td>
<td>1. Enter expense items as usual.</td>
</tr>
<tr>
<td></td>
<td>2. Synchronize them with BillQuick.</td>
</tr>
</tbody>
</table>
### Day-to-Day Integration Settings

<table>
<thead>
<tr>
<th>Record expenses in BillQuick and reimbursable expenses in QuickBooks</th>
<th>1. Enter copies, faxes and other resource usage expenses in BillQuick.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Record reimbursable expenses for employees and vendors in QuickBooks (e.g., from expense reports, download credit card statements) and assign to jobs.</td>
</tr>
<tr>
<td></td>
<td>3. Synchronize BillQuick and QuickBooks expenses.</td>
</tr>
<tr>
<td></td>
<td>4. Cut checks for employee and vendor reimbursements when ready.</td>
</tr>
</tbody>
</table>

Although you can send both expense entries and vendor bills from BillQuick to QuickBooks, QuickBooks accepts them only as vendor bills. When you are sending employee expenses to QuickBooks as bills, BillQuick prompts you to pre-define the Employee ID to Vendor ID switch. You can choose whether it is for all expenses or not, and specify the switch for different expenses. BillQuick can remember those settings and accordingly change the Employee ID to Vendor ID during the current sync and in future.

BillQuick vendor bills have a unique Bill No. (maximum length = 50 characters) and Reference (maximum length = 60 characters) while QuickBooks has a Reference No. (maximum length = 20 characters) only. BillQuick lets you map its vendor bill Reference field to the QuickBooks Reference No in the BillQuick-QuickBooks Integration Settings screen. Typically, in BillQuick you may enter the vendor’s invoice number in the Bill No. field. To avoid duplicate bill numbers, you can append it with a date or ID. E.g., if you received a bill from a vendor named ABC on May 25, 2011 with invoice number 2000, you can enter it as 2000-052510. Some of you may prefer to prefix it with the Vendor ID. Then it would be ABC-2000.

You can choose to get only specific type of expenses from QuickBooks by checking the ‘Skip Getting…’ options in the BillQuick-QuickBooks Integration Settings screen.

### Invoices

Creating invoices in BillQuick is the best course of action because it provides details critical to effective practice management. The most common synchronization setting for invoices is to send invoices from BillQuick to QuickBooks (‘Do Not Send box’ is unchecked and the ‘Do Not Get box’ is checked in the BillQuick-QuickBooks Integration Settings screen).

There can be an exception to this situation. For example, if you generate product invoices in QuickBooks and you want to record payments for all invoices, then you would not turn off getting invoices from QuickBooks.

Generally, invoices with zero value ($0) do not transfer from BillQuick to QuickBooks. You may generate zero dollar invoices in BillQuick in various ways:

- You may manually adjust the New Bill value to $0 in the Billing Review screen.
- You may generate a write-down on the invoice to $0 in the Time Entry or Billing Review screen.
Day-to-Day Integration Settings

- You may generate a manual invoice with a $0 value in the Manual Invoice screen.
- You may apply a huge discount to the bill amount, bringing down the Net Bill to $0 in the Manual Invoice or Billing Review screen.
- You may apply a retainer to the invoice, totally the Net Bill to $0 in the Manual Invoice or Billing Review screen.

The only exception to transferring a zero dollar invoice is in case of discounts and retainers. You can send such invoices to QuickBooks in spite of having a $0 bill value.

**Late Fee Invoices**

At times, you may include a late fee or finance charge on your invoices. In such cases, you will receive a payment for the invoice amount plus that late fee amount. Earlier BillQuick transferred the invoice amount to QuickBooks but did not transfer the late fee or its payment. In order for the accounts receivable to match in the two databases (reconciliation of transactions), you had to manually create a finance charge and corresponding payment in QuickBooks. The finance charge had to be for the exact amount of late fees.

However, BillQuick now allows you to transfer late fee charge to QuickBooks just as standard invoices. When you create a separate late fee invoice in Invoice Review screen, BillQuick generates a manual invoice internally with an invoice number same as that of the actual invoice but with ‘LF’ appended to it. The first late fee invoice will have the same invoice number but with a prefix of LF, and any subsequent late fee invoices will have initials LF1, LF2 and so on. Once created, you can transfer this manual late fee invoice to QuickBooks. You can also create a separate late fee payment for this invoice (excluding the principal amount) and then transfer it to QuickBooks. While transferring late fee invoices and payments, BillQuick will post them to the appropriate QuickBooks accounts.

You can specify an invoice account for Late Fee and override that account at the project level in the BillQuick-QuickBooks Integration Settings screen. You can even skip sending these invoices by checking that option.

**Payments**

You may decide to record payments for invoices and retainers in either BillQuick or QuickBooks. Or you may choose the convenience of entering payments in BillQuick. Mark the ‘Do Not Send’ and ‘Do Not Get’ options according to your preference.

In any case, you should make use of Date Filters in the Integration Settings screen to place less burden on the BillQuick and QuickBooks databases with unnecessary data transfer.
Real-Time Sync

Real-time synchronization means that data sync takes place automatically between BillQuick and QuickBooks when you update a record in either application. With real-time smart integration, data for critical activities can be shared between BillQuick and QuickBooks without having to enter it manually. Being completely automatic, it requires no action on your part. However, you will need to specify this option in the QuickBooks Integration Wizard or QuickBooks menu only once and then from that point onwards, your intervention is not required.

Real-time sync follows a set of rules that ensures accuracy and completeness of data in both company databases.

- Automatically synchronizes employee, client and vendor data added, deleted or updated in either BillQuick or QuickBooks
- Automatically synchronizes project data added or updated in either BillQuick or QuickBooks. If you delete projects in either BillQuick or QuickBooks, the corresponding records will not be deleted automatically in the other
- Automatically synchronizes invoices created in either BillQuick or QuickBooks. If you delete invoices in either BillQuick or QuickBooks, the corresponding invoices will not be deleted automatically in the other
- Automatically synchronizes payments received or deleted in either BillQuick or QuickBooks
- Automatically synchronizes time entries recorded in either BillQuick or QuickBooks. If you delete or update time entries in either BillQuick or QuickBooks, the corresponding entries will not be deleted automatically in the other
- Automatically synchronizes expense entries added or updated in either in BillQuick or QuickBooks
- Real-time data sync takes place on saving data in BillQuick, except for the time entry screens where data sync occurs on closing the screen

BillQuick provides certain options related to real-time sync. These include:

**Skip during Real-Time Sync:** If you opt for real-time sync but want to exclude certain type of data, you can use this option in the BillQuick-QuickBooks Integration Settings screen. You can skip real-time sync for any BillQuick module, while sending (Send Settings) as well as getting data (Get Settings).

**Ask before Delete:** If you use this option from the QuickBooks menu, you will be prompted to confirm deletion of any record in BillQuick after it is linked with QuickBooks via sync. Otherwise, if any record is deleted in BillQuick, the corresponding record is also deleted automatically in QuickBooks.

**Connect in Single User Mode:** If you connect to or open QuickBooks company file in a single-user mode, no other application or user can work on that company file during that session. This results in faster data synchronization when sending data from BillQuick to QuickBooks.
Day-to-Day Integration Settings

The advantages of connecting in this mode include:

- Certain QuickBooks features require that a user operate in single-user mode. For instance, a company file must be opened in single-user mode for you to delete any of its list items.
- Locking and opening protection. If a company file has not been opened by another QuickBooks-integrated application, BillQuick can open it with exclusive access. This locks out other applications, gaining improved performance.

The disadvantages of connecting in this mode include:

- If BillQuick attempts to open a QuickBooks company file in single-user mode and that company file is already open in multi-user mode, BillQuick will not be able to access it. If BillQuick does not use this mode, it can share access to the company file.
- BillQuick locks out other applications, denying them access to the company file. In environments that are known to need multi-user access, this cannot be done.

Subscribe to QB Events: When you integrate BillQuick with QuickBooks, you may want to know about changes to data in the company file when they occur. For example, in case of QuickBooks customer or employee data, BillQuick may need to know if a customer or employee is added, modified, or deleted. Similarly, it may also need to know about the opening or closing of the company file and so on. In order for you to receive notifications about these events, the event notification framework must know about the application and the events it wants to receive. Thus, BillQuick must be subscribed to QuickBooks events before it can receive notification about it.

After the first real-time sync operation, you can subscribe to QuickBooks program in order to fully utilize this capability. The QB Event mechanism applies only to company files opened in interactive mode and not if QuickBooks is in auto-login (background) mode. QuickBooks does not need to run when you subscribe/unsubscribe BillQuick for event notification. The subscribe/unsubscribe feature does not go into effect immediately. It happens when the company file is next opened by QuickBooks or when QuickBooks is next started. This feature should be used when you have not checked the Real-Time Sync option in the QuickBooks Integration Wizard and then activate it from the QuickBooks menu. After subscription, data is automatically updated in both applications in the event of any data modification.

📢 If you uninstall BillQuick, you should always unsubscribe from any events to which your application is subscribed.
Best Practices

<table>
<thead>
<tr>
<th>Items</th>
<th>BillQuick</th>
<th>QuickBooks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Vendors</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Activity/Service items</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Expense/Charge Items</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Clients</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Projects</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Classes</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Estimates/Budgets</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Service Fee Schedules</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Chart of Accounts</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Time</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Billing</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Accounts Payable</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Invoices</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Payments</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Bills &amp; Checks</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Payroll</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Reports</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Financial Statements</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Banking</td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

Congratulations! You have now an advanced understanding of data integration between BillQuick and QuickBooks, how to ensure that the data transfer is accurate and how to verify which records have integrated. To learn more, check the BillQuick Help or attend a Training course.

For more information, visit us at www.bqe.com. If you have any trouble in using our integration utility, please contact BillQuick Support at (310) 602-4030 or Support@bqe.com. For other questions, please call us at (888) 245-5669 (US and Canada) or (310) 602-4020; or email Sales@bqe.com.